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INTRODUCTION TO POLAR CARDIO GX 

Welcome to Polar Cardio GX! Polar Cardio GX is a Polar solution for group exercise at fitness 
and health clubs. Cardio GX enables arranging heart rate-based classes where the heart rates of 

participants are displayed on a screen. Polar Cardio GX is suitable for different kinds of indoor 
and outdoor group exercise sports 

 

The Polar Cardio GX system 

The Polar Cardio GX system consists of a PC software, a base station, transmitters (strap and 

connector) and a charger. Find out more about the hardware in the hardware section of this help.  

The PC software consists of two parts:  

 admin tool allows managing the sessions, advertisements and hardware;  

 session tool is used before a class for signing up, during the class for heart rate 
monitoring, and after the class for summarizing the individual heart rate data. 

We recommend that you read through this manual before beginning to work with the Polar Cardio 
GX system. It is the easiest way to learn how to utilize the system at your club.  

1 



Polar Cardio GX: Help Topics 

Quick steps 

1. Install the PC software from the CD. 

2. Set up the system (sessions and hardware) with admin tool. 

3. Give the transmitters to the exercisers. 

4. The exercisers sign up for the session (in the session tool). 

5. Instructor starts the heart rate-based group exercise class! 

6. An individual session summary is displayed for each exerciser after the class. 

7. Follow up arranged heart rate-based classes. 

PC requirements 

For proper and smooth operation of the Polar Cardio GX software, make sure your PC meets the 

following requirements: 

Minimum system requirements are: 

 1.6 GHz processor 

 1 GB RAM 

 1 GB of free hard drive space 

 XGA (1024 x 768) monitor 

 Microsoft Windows XP or Vista (32-bit) 

Recommended system requirements are: 

 2 GHz processor 

 2 GB RAM 

 1 GB of free hard drive space 

 Wireless connection (IEEE802.11b or newer), WEP encryption 

 Microsoft Windows XP or Vista (32-bit) 
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In addition to the requirements listed above, it is recommended that you update system drivers, 
especially Wi-Fi adapter drivers. Contact your Wi-Fi adapter manufacturer's web site to find the 

latest release of the drivers. 

Training articles 

For more information on the physiological aspects and other features of Polar products, visit the 

Polar Collection of Training Articles. 

Bluetooth 

Polar Cardio GX uses Bluetooth wireless communication between the transmitters and the base 
station. Bluetooth provides the most reliable and secured technology for transmitting live data in 

the sports instrument industry today.  

http://www.polar.fi/en/training_with_polar/training_articles




 

HARDWARE 

Introduction to hardware 

The Polar Cardio GX system includes the following hardware: 

 Base station 

 Charger  

 Ten transmitters consisting of connectors and straps. Extra connectors and transmitter 

straps can be purchased separately. 

The light and sound indicators are presented in the Lights and sounds topic. 

Base station 

The base station is the device that connects the transmitters with the PC software. The easiest 

way to connect the base station with the PC is to use a network cable. Wireless connection can 
also be used. 

 How to connect base station to PC 

 How to set up wireless connection 
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Front panel 

 

1. Charger and power indicators (see Lights and sounds) 

2. Number indicators for connections and a Bluetooth logo (see Lights and sounds) 

3. Power button 

4. Ethernet port and power plug under the cover 

Facts 
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Hardware 

 The base station is water-resistant. It can be used also outdoors and in the rain as long 
as the plug is in place. Always use wireless connection and battery power in the rain! 

 AC adapter is included in the Cardio GX set. There are four different plugs for the AC 
adapter. Choose the correct plug (according to the country) and place it into the adapter. 

 During charging the legs of the base station must be used because the bottom of the 
base station heats up to 60°C (140°F). During charging, the maximum operating 

temperature is 45°C (113°F). 

 The detachable legs must be used when base station is placed on moist ground, e.g., on 

a wet lawn.  

 When the base station is placed on the wall, the plug must be towards the ground, 

especially outdoors. 

 It is recommended that the base station is placed 2 meters (6.5 ft) above the ground to 

optimize the signal. 

 Check the range of the signal if the base station is surrounded by metal. 

 A wall mounting kit is included in the Cardio GX set. The sockets that are provided in the 
wall mounting kit are meant for concrete surfaces. 

Technical features 

 Allows you to display up to 28 exercisers' heart rates simultaneously in real time. 

 Built-in Wi-Fi (IEEE802.11b) to allow wireless connection between the PC and the base 
station. 

 Built-in Bluetooth (100 m (330 ft) range) 

 RJ45 connector for Ethernet connection 

 Re-chargeable batteries with up to 12 hours stand alone use. Charging time 4 hours 

 Operating temperature -20°C - +60°C (-4°F - +140°F) 

Charger 

The charger is used to re-charge the batteries of the connectors. The charger can only be used 

indoors.  
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Data transfer between the connectors and the PC is enabled only when the connectors are 
inserted into the charger and the power cable is plugged into the charger. 

 How to insert connectors into the charger 

 

Facts 

 Up to ten connectors can be inserted into the charger at a time. 

 The connectors are inserted into the charger with the led light left on the outside. The led 
is located next to the Polar Team2 logo's letter R. 

 Only for indoor use (not water-resistant) 

 AC adapter is included in the Cardio GX set. There are four different plugs for the AC 

adapter. Choose the correct plug and place it into the adapter. 

 A wall mounting kit is included in the Cardio GX set. 

Transmitters 

The transmitter consists of a transmitter strap and a connector. The connector detects the heart 

rate and transmits it to the PC via base station using Bluetooth. During training the heart rate data 
can also be monitored with a compatible Polar training computer.  

 How to insert connectors into the charger 

 How to teach connectors to the system 

8 



Hardware 

 How to use transmitters 

 

Facts 

 Connector is water-resistant. 

 The connector is in the sleep mode if it's not inserted into charger or attached to the 
strap. 

 If the data transmission ceases during training, the connector searches for a new 
connection automatically. 

 For example, the following Polar training computers can be used with the transmitter: 
FT40, FT60, FT80, F4, F6, F7, F11, F55, FS1, FS2, FS3, RS300X, RS400. Full list of 

compatible training computers can be found at Polar website. 

 The strap works only with a Team2 connector.  

Technical features 

 Re-chargeable battery, up to 30 hours of stand alone use. Charging 24 hours 

 Connectors with Polar magnetic communication technology 

 Built-in Bluetooth (100 m (330 ft) range) 

 See transmitter strap and connector materials in Technical specifications topic 

Lights and sounds 

9 

http://www.polar.fi/en/products/accessories/all_compatible_products?category=23&product=8194&op=Find


Polar Cardio GX: Help Topics 

The base station and connectors include different lights and sounds to inform their status to the 
user. 

Base station 

The lights are located in the front panel of the base station. 

Light Function 
Charge indicator 

 

Green light is on: Power cable is connected and/or the battery is full. 
Red light is on: Battery is low and charging. 
Red light is blinking every 5 seconds: Battery is low and not 
charging. 
Red light blinks for 3 seconds and power switches off 
automatically: Battery is empty. 

Power indicator  
 

Base station is on. 

Blue 1  
Base station is ready for use. It takes approx. 1 minute to light up 
after switching on. 

Blue 2  
PC is connected to the base station and the software is running. 

Blue 3  
At least one connector is connected to the base station with 
Bluetooth. 

Blue 4  
Not in use. 

NOTE: 

 The Bluetooth logo   is not a light; it is only a label. 

Connector 

See the table below for a description for lights and sounds during training. 

Light/Sound Function 
Green led is blinking 
at the same pace 
with heart rate. 

Connector detects the HR signal and is ready for transmitting.  

Red led is blinking at 
the same pace with 
heart rate. 

Connector detects the HR signal and is ready for transmitting. 
Memory or battery level is low. 

Start transmitting 
sound, one beep. 

Connector starts detecting and transmitting heart rate. 

Green led is blinking 
every 3 seconds. 

Connector is transmitting. 

Stop transmitting 
sound, two beeps. 

Connector stops detecting and transmitting heart rate. 

Red led is double 
blinking every 5 

Transmitting cannot be started. 
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seconds for 30 
seconds. 
Stop recording 
sound. 
Red led is double-
blinking every 5 
seconds for 10 
minutes. 
Stop transmitting 
sound. 

Transmitting has been stopped because the battery is empty. 

See the table below for a description for lights and sounds during charging/while the connectors 

are in charger. 

Light/Sound Function 
Red led is on for 5 
seconds. 
Short sound. 

Connector is properly placed into the charger. 

Red led is blinking 
every 5 seconds. 

Connector is charging. 

Green led is blinking 
every 10 seconds. 

Connector's battery is full. 

Green led is on. During teaching, the user can activate the connection between a new 
connector and the system by removing the connector from the 
charger. 

Red led is on for 5 
seconds. 
Three short sounds. 

Connector is properly placed into the charger, but is in non-secured 
mode. Connector cannot communicate with the system while it is in 
non-secured mode. 
   
To change the mode to secured, remove the connector from the 
charger and insert it back after a minimum of three seconds. Only 
one sound should be heard.  

 





 

SOFTWARE 

Introduction to software 

The Polar Cardio GX software consists of two parts:  

 admin tool for managing the sessions, advertisements and hardware;  

 session tool is used before a class for signing up, during the class for heart rate 
monitoring, and after the class for summarizing the individual heart rate data. 

The admin tool is opened from the Windows desktop (Polar Cardio GX Admin Tool) or from 
the Start menu: Start > All Programs > Polar Cardio GX > Polar Cardio GX Admin 
Tool.  

The session tool is opened by double-clicking the Polar Cardio GX Session Tool shortcut on 
the Windows desktop. 

The Polar Cardio GX software saves a log file with session details from every session allowing 
following up the arranged heart rate-based sessions. For more information, see How to follow up. 

 

Admin tool 

Admin tool 

Admin tool is opened from the Windows desktop (Polar Cardio GX Admin Tool) or from the 
Start menu: Start > All Programs > Polar Cardio GX > Polar Cardio GX Admin Tool. 

The admin tool allows you to manage sessions, advertisements and hardware. The admin tool is 
meant for Cardio GX system's key users. 

 Manage the sessions on the left side of the admin tool. 

 Manage the system on the right side of the admin tool. 

13 
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Menu 

File 

Close the admin tool by selecting File > Exit from the main menu.  

Help 
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Software 

Open the software help by selecting Help > Help topics or  bypressing F1 on the keyboard. 

Check software updates by selecting Help > Check for updates. 

Check the Polar Cardio GX software's version and other information by selecting Help > About. 

Language selection 

 

Change the language of the Polar Cardio GX software by selecting the desired language from the 
drop-down list in the upper right corner. The available languages are English, German, French, 

Spanish, Italian and Portuguese. The new language is taken into use after restarting. 

Session management 

You must create sessions before arranging heart rate-based classes. Sessions are added, 

defined, modified and removed in Session Management on the left side of the admin tool. The 
number of sessions is not limited.  

NOTE: The admin tool and the session tool cannot be open simultaneously. Therefore, close the 
session tool before modifying the sessions. 

Every session has a name, three to five intensity zones, a type and optionally also 
advertisements. Each intensity zone has a distinctive color, name, and lower and upper heart rate 
limits.  

Sessions can be used as templates for different kinds of heart rate-based classes. For example, 
after a "Light indoor cycling" session is created in the admin tool, it can be used in each light 

indoor cycling class your club arranges.  

Sessions 
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At the top of the Session Management section of the admin tool, there is a list of current 

sessions. Polar Cardio GX includes one default session (PolarZone session).  

Click Add to create a new session and Remove to remove the selected session. To modify a 

session, select it and make changes in Session properties. Changes are saved automatically.  

There must always be at least one session in the system. The software does not allow you to 

delete all the sessions. 

Session properties 

 

When you have either created a new session by clicking Add next to the session list or have 
selected an existing session to modify it, the session information is displayed in Session 

properties. You can modify the name, the type and the intensity zones of the session. 

Changes are saved automatically. To restore default session properties for the selected session, 

click Defaults. 

16 
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Intensity zones 

A session can include from 3 to 5 intensity zones and you can set color, name and the lower 

limits for each zone. 

To delete an intensity zone, click the delete icon  next to the zone. The software asks for your 

confirmation. NOTE: Only the lowest zone can be deleted. To reduce the number of zones from 5 
to 3, delete first the lowest zone and then the second lowest zone. 

 To add an intensity zone, click the Add button next to the intensity zones. 

Session types 

Each session has a type. The type determines whether the intensity zones are based on 
maximum heart rate (HRmax) or anaerobic threshold. The session type is set by selecting one of 
the two options next to the session name under Session properties. The type can be changed 

when modifying session properties. 

When maximum heart rate is selected as the session type, the intensity zones are based on the 

maximum heart rate. The exercisers cannot exceed their maximum heart rates during the class, if 
the maximum heart rates are set correctly during signing up.  

When anaerobic threshold is selected as the session type, the intensity zones are based on 
anaerobic threshold which is the 100% point but not the maximum heart rate point. When 
anaerobic threshold is exceeded, muscles start to work without oxygen. NOTE: In order the 

anaerobic threshold intensity zones to work properly during a training session, the exercisers 
must know their anaerobic thresholds and set them correctly during signing up. 

Advertisements 

 

Each session can include advertisements that are displayed on the screen during the session. 
The number of ads is not limited. To add an advertisement to the selected session, select Add 

below the Advertisements list and browse the ads from your computer one by one.  

A preview of the selected ad is displayed next to the ad list.  

17 
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To remove an advertisement, select it from the list and click Remove below the list.  

Advertisement format: 

 Advertisements must be either in JPG, PNG, BMP or GIF format.  

 It is recommended that the advertisements have a certain aspect ratio. The best result is 
achieved when the aspect ratio of an advertisement is 3:1. For example, a good size for 

advertisement is 600 x 200 pixels. 

 The size of an advertisement should be less than 2 MB. 

 Tip: To get the best visual outcome, it is recommended to use PNG (or GIF) pictures that 
have transparent background. See the example pictures below: on the left a JPG ad 

without transparent background and on the right a PNG ad with transparent background. 
 

 
 

For more information about transparency in picture files, contact your technical support or 
advertisement agency.  

System management 

Use the System Management part of the admin tool to set up the Polar Cardio GX system and 

hardware before arranging heart rate-based classes. 

To get visual instructions on how to setup the Polar Cardio GX hardware, click the question mark 

icon  in the upper right corner.  

Base station 
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After the base station is connected to the PC and the admin tool is running, the base station 

image, the base station connection Status, Name (Polar_XXXXXXXX) and Wireless network 
key are displayed. The base station name is also the name of the base station's wireless 
network.  

The wireless network key is a password that is required when establishing a wireless connection 
between the base station and the PC. By default, the wireless network key is "Polar". It is 

recommended to change the wireless network key when using the Polar Cardio GX system for 
the first time to ensure your system security. 

If the base station is connected to the PC with a wireless connection, it is not recommended to 
change the wireless network key. 

 How to connect base station to PC 

 How to change the wireless network key 

Connectors 
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Before you can use transmitters for online monitoring, the connectors must be introduced to the 
system (base station and the PC software). This is called teaching. It takes only a few minutes, 

and it has to be done only once for every connector. You can teach up to 28 connectors to the 
system. 

If you purchase more connectors, you will have to teach them also. 

You can also remove connectors from the system by using the admin tool. 

 How to teach connectors to the system 

 How to remove connectors from the system 

Connectors that you have introduced to the system are listed in the Connectors list under In 

Charger and Not in Charger headings. 

Session tool 

Session tool 

Open the session tool by double-clicking the Polar Cardio GX Session Tool shortcut on the 

Windows desktop. You can also open it from the Start menu: Start > All Programs > Polar 
Cardio GX > Polar Cardio GX Session Tool. 

The Polar Cardio GX session tool is used to arrange heart rate-based classes. It is used before a 
class for signing up, during the class for heart rate monitoring, and after the class for summarizing 

the individual heart rate data. 

The Polar Cardio GX software records a session log for each session. The log file can be used to 

follow up and monitor the arranged heart rate-based classes. See After training topic for more 
information. 

The session tool opens into a full screen mode. You can close it from the Instructor Settings 

view and after a session by clicking the Exit button .  

While the session tool is running, you can access your Windows desktop by pressing the 
Windows key on your keyboard. If you have other applications running simultaneously, <Alt> + 

<Tab> key combination allows you to toggle between applications. 

See also: 

 Before training 
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 During training 

 After training 

Screen saver 

It is recommended that you turn off the screen saver or set the screen saver wait time to 90-120 

minutes.  

Windows XP: 

1. Start > (Settings >) Control Panel > Display > the Screen Saver tab. 

2. Turn off the screen saver by selecting None from the drop-down list or set the Wait time 
to 90-120 minutes. 

Windows Vista: 

1. Start  > Control Panel > Personalization > Screen Saver. 

2. Turn off the screen saver by selecting None from the drop-down list or set the Wait time 
to 90-120 minutes. 

 

Before training 

Before starting a training session, the Cardio GX system must be set up in the admin tool. The 
setup includes both hardware and session configuration. Club employees must be taught to use 

the system and club customers must be taught to use the transmitters and sign up for a training 
session. 

21 
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Before the first heart rate-based class: 

1. Install the Polar Cardio GX software. 

2. Set up the hardware (base station and connectors). 

3. Set up at least one session. You can also use the default session (PolarZone session). 

4. Set up the system to the room where you intend to use Polar Cardio GX. 

5. Instruct your club employees to use the system. 

Before every heart rate-based class: 

1. Give transmitter connectors to the exercisers, for example at the reception. Make sure 
the exercisers know their connector numbers. The number is needed when signing up. It 
can be found at the label on the connector. 

 

2. Exercisers put on the transmitters in the locker room according to the instructions. 

3. The instructor sets up the Polar Cardio GX ready for the heart rate-based class. 

4. The instructor selects the training session in the Instructor Settings view and types in 
his/her information. The instructor selects Exerciser sign-up. See more detailed 
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instructions for instructor settings in How to start session. 

 

5. After the instructor has selected the session and set up his/her information, the 
exercisers sign up for the class with the PC. See more detailed instructions for signing up 
in How to sign up. 

6. Instructor selects Session in the Sign-up view. 

NOTE: The session tool can be closed by clicking the exit button  in the Instructor 

Settings view. The software asks for your confirmation. 

Continue to the During training topic. 

During training 

After the instructor has selected Session in the Sign-up view (see Before training), a grid with 
names is displayed on the screen. Exercisers and the instructor can locate their names before a 

session starts. Possible advertisements are already shown and the timer is displaying 00:00. 

To begin the heart rate-based class, the instructor clicks the start button . A countdown 

from 3 to 1 is displayed. The timer starts to run and heart rates appear on the screen. The 

instructor can guide the exercisers based on the heart rates or intensity zones. 

The exercisers can also monitor and record their heart rate with a compatible Polar training 

computers. See an example list in the Transmitter topic. 

Controls 
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 Pause the session by clicking the pause button . To continue the session, click 

the start button . 

 End the session by clicking the stop button . To start a new session with the 

same exercisers' data, click the start button . See more information in the After 

training topic. 

 Before the session is started or when the session is stopped (the stop button), the 

settings button  becomes enabled. Change the session settings by clicking the 
settings button, selecting a new session and selecting OK. 

Continue to the After training topic. 

Intensity zones 

During training the intensity zones are displayed at the bottom of each exerciser's heart rate box 

with colors selected in the session settings in the admin tool. The background color of the heart 
rate box changes according to the intensity zone where the exercisers are in. 

The instructor can guide the exercisers using either the intensity zone number (e.g. "train in 
zone 3"), the intensity zone color (e.g. "train in green zone") or the percentage of the heart 

rate maximum (e.g. "train at 60 - 65 % intensity"). 

Problems? 

If exerciser's heart rate disappears from the screen ("- -" displayed instead), the connection 

between the connector and the base station is momentarily disconnected or the strap's electrode 
areas are dry. For more information, see Online training topic in the troubleshooting chapter. 

After training 

After the instructor has ended the training session by clicking the stop button  (see 

During training), the Polar Cardio GX software displays an individual session summary for each 
exerciser. In addition to the exerciser's name, the average and maximum heart rate is displayed 
with the intensity zone summary. To be able to compare the times spent on each intensity zone, 

the durations are displayed in minutes and seconds and with colored bars. 

The instructor can discuss about the results with the exercisers and end the session by selecting 

the exit button .  
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The exercisers follow the care and maintenance instructions with the transmitter straps and 
connectors, and return the connectors to the reception. 

Starting a new session 

After the session has ended, it can be started again with the same exerciser data by clicking the 

start button . The timer is set to 00:00 again and previous heart rate data is erased.  

When the session is stopped (the stop button), the settings button   becomes enabled. 

Change the session settings by clicking the settings button, selecting a new session and selecting 

OK. Sessions that are different type than the current selected session are disabled. 

NOTE: After the session tool is closed by clicking the exit button , all the exerciser 

information (name, maximum heart rate / age) is lost and exercisers must sign up again to be 
able to participate to the session. 

Log file 

The Polar Cardio GX software records a session log for each session. The log file can be used to 
follow up and monitor arranged heart rate based classes. The log file tells you what kind of 

sessions have been held and did the sessions meet the requirements and thus helps you to 
improve your club's quality. The exercisers come back if the sessions are what you promise them 
to be. 

The log file gives you answers for example to the following questions: 

 Was the "Light indoor cycling" session really light or were the exercisers on the highest 
zone too much? 

 Did the instructor push the exercisers to the their limits during the "Maximize your 
fitness" session? 

Location 

The log file can be accessed from the admin tool. To open the log file, click on the log file button 

 in the upper right corner of the Session Management section of the admin tool. The 

Sessions.csv file opens into Microsoft Excel or similar software. Make sure you have compatible 
software installed onto your computer. 

Reading the file 
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All the session logs are stored into one Sessions.csv file. There is one line for each session in the 
file. The newest session is at the bottom of the list. You can easily copy and paste the information 

into another document. 

The Sessions.csv file consists of 16 columns. 

 

 Date - The date of the session. 

 Start Time - The time the session started. 

 Duration - The session duration displayed in hours, minutes and seconds. 

 Instructor - The name of the session instructor. 

 Exercisers - The number of exercisers in the session. 

 Session - The session name. 

 Zone 1 Time, Zone 2 Time, Zone 3 Time, Zone 4 Time, Zone 5 Time - The 

percentage of time spent in each zone. All exercisers' times in each of the zones is 
summed up and shown as percentages of total time. Total time is exercisers' training 
durations summed up, differing from Duration.  

 For example, if there were 20 exercisers in the session, and 10 of them trained 
10 minutes (10 x 10 minutes) and the other 10 trained 5 minutes (10 x 5 minutes) 

in zone 1, and the total duration of the session was 1200 minutes (20 x 60 
minutes), the Zone 1 Time would be 12,50 % (150 minutes out of 1200 
minutes).  

 Zone 1 Total Time, Zone 2 Total Time, Zone 3 Total Time, Zone 4 Total Time, 
Zone 5 Total Time - The total (combined) durations in each zone. All exercisers' 

durations in each of the zones is summed up and the sums are displayed in the five 
columns. The total times are displayed in hours, minutes and seconds.  

 For example, if there were 20 exercisers in the session and 10 of them trained 10 
minutes in zone 1, and the other 10 trained 5 minutes in zone 1, the Zone 1 
Total Time would be 150 minutes.  



 

HOW TO 

How to 

How to articles are divided into following categories: 

 Connections 

 Transmitters 

 Session management 

 Sessions 

There are also two separate How to articles: 

 How to set up hardware, and 

 How to follow up. 

How to set up hardware 

The Polar Cardio GX system and hardware must set up before heart rate-based classes can be 
arranged. This is done in the System Management part of the admin tool. The hardware 

setup includes selecting the wireless network key and teaching of the connectors. 

After installation of the Polar Cardio GX software: 

1. Open the admin tool from the Start menu: Start > All Programs > Polar Cardio GX > 
Polar Cardio GX Admin Tool. 

2. Plug in the power cable into the base station and the wall outlet. 

3. Connect the base station to the PC with the network cable provided in the set. The lights 

 and  are lit on the base station front panel when the connection between the 
base station and the PC is ready. 

4. Select a wireless network key for the base station. 

5. Teach connectors to the system. 

Also visual instructions on how to setup the Polar Cardio GX hardware are available in the admin 

tool: click on the question mark icon   in the upper right corner to open the instructions. 
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Hardware setup is instructed step by step with helpful animations. Change the animation by 
clicking the steps on the left. 

 

Before each session 

At the beginning of each session, the Polar Cardio GX system must be set up to the Cardio GX 

room.  

1. Open the session tool from the Windows desktop by double-clicking the Polar Cardio 
GX Session Tool shortcut. 

2. Plug in the power cable into the base station and the wall outlet. 

3. Switch the base station on. 

4. Connect the base station to the PC with the network cable provided in the set or by using 

the wireless connection. The lights  and  are lit on the base station front panel 
when the connection between the base station and the PC is ready. 

The Polar Cardio GX is now ready for sign-up. 

Connections 
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How to connect base station to PC 

The base station can be connected to the PC with either an Ethernet cable (cross-over) or 

wireless connection. When Cardio GX is taken into use for the first time, the base station must be 
connected to the PC with the Ethernet cable.  

To connect the base station to the PC: 

1. Turn on your PC and open the Cardio GX software (either the admin or session tool). 

2. Plug the power cable into the base station and the wall outlet. NOTE: Using power cable 
is only allowed indoors. In outdoor use, use the battery as power source. 

3. Connect the base station to the PC with the network cable provided in the set. NOTE: 
The cable must be a crossover RJ45 cable. 

4. Switch on the base station. Wait until  and  are lit (approx. 1. min) on the base 
station. 

 When you open the admin tool, the base station image becomes visible at the 
same time. 

 

 If you open the session tool, only the light indicator   on the base station front 
panel shows when the connection is ready. 

When the lights  and  are lit, the base station is ready to communicate with the PC 
software. 

See also: How to setup wireless connection. 

See detailed step-by-step help in the Connections topic in the troubleshooting chapter. 

How to set up wireless connection 
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The base station can be connected to the PC with either an Ethernet cable (crossover) or 
wireless connection. Instructions for creating a wired connection between the base station and 

PC can be found here. A wired connection is necessary when Cardio GX is used for the first time. 

Wireless connection requires that there is a Wi-Fi adapter installed into the computer you are 

using with the Cardio GX system.  

Wireless network key 

Wireless connection requires a wireless network key (=password) to establish a secured wireless 

connection from the PC to the base station. A secured connection prevents an outsider from 
connecting to the base station's wireless network. Wireless network key is selected in the admin 
tool. Wireless network key can be changed when the base station and the PC are connected with 

a network cable and the admin tool is running.  

It is recommended to change the wireless network key when using the Polar Cardio GX system 

for the first time to ensure your system security. 

Changing/selecting the wireless network key 

1. Turn on your PC and open the admin tool from the Start menu: Start > All Programs > 
Polar Cardio GX > Polar Cardio GX Admin Tool. 

2. Connect the base station to the PC with the network cable provided in the set.  NOTE: 
The cable must be a crossover RJ45 cable. 

3. Switch on the base station. Wait until  and  are lit (approx. 1. min) on the base 
station. The base station image becomes visible at the same time. 

4. Replace the default wireless network key ("Polar") by typing a new one into the 
Wireless network key text field in the upper right corner of the software.  

5. The software instructs you to select a password that is either 5 or 13 characters long. If 
the network key is too short, the background of the field is red. 

 

6. Save the new wireless network key by clicking the save wireless network key button . 
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NOTE: If you have forgotten your wireless network key, connect the base station to the PC with 
the network cable and go through the Changing/selecting the network key steps. 

Establishing Wireless Connection 

Your computer should remember the wireless connection settings. Therefore, the wireless 
connection has to be set only once. 

Windows XP 

1. Switch on the base station. Wait until   on the base station is lit.  

2. If there is a separate on/off switch for the wireless adapter (on the PC), make sure that 
the adapter is switched on. 

3. In Windows, open Network Connections by selecting Start > (Settings >) Control 
Panel > Network connections. 

4. If the wireless adapter is disabled, right-click Wireless Network Connection and 
select Enable.  

5. Right-click Wireless Network Connection and select View Available Wireless 
Networks. 

6. Wait for couple of seconds while the computer searches the networks. If your base 
station's name (Polar_XXXXXXXX) does not appear on the list, try to refresh the list by 

clicking Refresh network list on the left panel.  

7. Select Polar_XXXXXXXX from the networks list and click Connect.  

8. You are asked to give the network key to finalize the connection.  on the base station 
is lit when the Cardio GX software is running and the connection is OK.  

Windows Vista 

1. Switch on the base station. Wait until  on the base station is lit.  

2. If there is a separate on/off switch for the wireless adapter (on the PC), make sure that 
the adapter is switched on. 

3. In Windows, open Network and Sharing Center by selecting Start > Control Panel > 
Network and Sharing Center.  

4. Click View status of the wireless network connection.  
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5. If the Media State is disabled, click the Enable button at the bottom of the window. 

6. Select Start > Connect to.  

7. Wait for couple of seconds while the computer searches for the networks. If your base 

station's name (Polar_XXXXXXXX) does not appear on the list, try to refresh the list by 
clicking the Refresh button in the upper right corner. 

8. Select Polar_XXXXXXXX from the networks list and click the Connect button. 

9. You are asked to give the network key to finalize the connection.  on the base station 

is lit when Cardio GX software is running and the connection is OK.  

Note 

 If you are using different software, provided by the PC or wireless adapter manufacturer, 
to manage wireless connections, these instructions do not apply. In that case, you can 
find more information from the connection management software's help or web site. 

 If you have problems connecting to the base station: 

 Some computers block the Wi-Fi connection automatically if the Ethernet cable is 
plugged in even though the Wi-Fi adapter is enabled. If this is the case, remove 
the Ethernet cable from the PC's Ethernet port. 

 Some computers block the Wi-Fi connection automatically if you are using a 
docking station. If this is the case, remove the laptop from the docking station. 

See detailed step-by-step instructions in the Connections topic in the troubleshooting chapter. 

Transmitters 

How to insert connectors into charger 

Connectors are inserted into charger for two reasons: 

 To recharge the batteries 

 To teach new connectors to the system 

Inserting the connectors into the charger: 

1. Plug in the power cable into the charger. 
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2. Insert connectors into the charger so that the P of the Polar logo is not visible. The led 
light is left on the outside. The led is located next to the Polar Team2 logo's letter R. 

 

3. When a connector is inserted correctly into the charger, the red led on the connector is lit 

for 5 seconds. At the same time you can hear a short sound.  

 If the admin tool is open and the base station is connected to the PC, the admin 

tool displays which connectors are connected to the base station. 

Connectors inserted correctly into the charger (note the position of the led lights): 
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How to teach connectors 

Before you can use transmitters for online monitoring, the connectors must be introduced to the 

system (base station and the PC software). This is called teaching. It takes only a few minutes, 
and it has to be done only once for every connector. You can teach up to 28 connectors to the 
system.  

If you purchase more transmitters, you will have teach them also. 

The connectors can also be removed from the system by using the admin tool. 

1. Turn on your PC and open the admin tool from the Windows desktop (Polar Cardio GX 
Admin Tool) or from the Start menu: Start > All Programs > Polar Cardio GX > 
Polar Cardio GX Admin Tool. 

2. Connect the base station to the PC either with the network cable provided in the set or 
with a wireless connection. 

3. Switch on the base station. Wait until  and  are lit (approx. 1. min) on the base 
station. The base station image in the admin tool becomes visible at the same time. 

4. Plug in the power cable into the charger and insert the (new) connectors into the charger. 

5. Wait until   is lit on the base station. New connectors appear to the Connectors list 
under New in the admin tool. 
 

 

6. To teach a connector, select it from the New list. Wait until the number moves under the 
heading In Charger. NOTE: It may take approx. 10 seconds. 

34 



How to 

 

 

7. A green light starts blinking on one of the connectors in the charger. Remove the 
connector with a green blinking light from the charger to finalize the teaching. The 
removed connector moves under Not in Charger heading in the admin tool. 

 NOTE: Do not click the Remove button below the list during teaching. It is for 
removing the connectors from the system. 

8. Mark the removed connector with a correspondingly numbered sticker. 

9. Repeat steps 6 to 8 until you have taught all the connectors to the system. 

If you re-insert the taught connectors into the charger again, they appear in the Connectors list 

under In Charger. 
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How to remove connectors from system 

A connector may brake and can be replaced with a new one. The old connector must be removed 

from the system before teaching the new connector. You can reteach connectors at any time.  

If you want to remove a connector from the system (base station and the PC software), follow the 

steps below.  

1. Turn on your PC and open the admin tool from the Windows desktop (Polar Cardio GX 
Admin Tool) or from the Start menu: Start > All Programs > Polar Cardio GX > 
Polar Cardio GX Admin Tool. 

2. Connect the base station to the PC either with the network cable provided in the set or 
with a wireless connection. 

3. Switch on the base station. Wait until  and  are lit (approx. 1. min). The base 
station image in the admin tool becomes visible at the same time. 

4. Plug in the power cable into the charger and insert the connectors into the charger. 

5. Wait until   is lit on the base station. Connectors in the charger appear to the 
Connectors list under In Charger in the admin tool. 
 

 

6. Select a connector from the list and click the Remove button below the list. The software 
asks for your confirmation. 

7. Repeat step 6 for each connector you want to remove. 

How to use transmitters 
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In order to the transmitters to work properly (detect and transmit heart rate data), follow the 
instructions below. 

1. Wet the electrode areas of the strap well under running water. 

2. Attach the connector to the strap. Adjust the strap length to fit tightly but comfortably. 

3. Tie the strap around your chest, just below the chest muscles, and attach the hook to the 
other end of the strap. 

 Note that if you are wearing a sports bra, place the strap below the bra. 

4. Check that the wet electrode areas are firmly against your skin and that the Polar logo of 
the connector is in a central and upright position.  

 When the transmitter starts detecting and transmitting your heart rate, you can 
hear a short beep and a green light starts blinking on the connector. Now you 

can also monitor your heart rate with a compatible Polar training computer. 

After training, detach the connector from the strap and follow the care and maintenance 

instructions. 

NOTE: A Team2 connector can be used only with a Team2 strap.  

How to recharge connector batteries 

1. Plug in the power cable into the charger and the wall outlet. 

2. Insert connectors into the charger. Recharging begins automatically. 

When green leds start blinking on the connectors, the batteries are full. 

Session management 

How to add session 

Before sessions can be used during class, they must be created in the admin tool. Polar Cardio 

GX includes one default session (PolarZone session).  

The number of sessions is not limited. All the changes are saved automatically. 

1. Open the admin tool from the Start menu: Start > All Programs > Polar Cardio GX > 
Polar Cardio GX Admin Tool. 
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2. Under Session Management, click the Add button. A new session appears in the 
Sessions list. 

 

3. Select the session and type in the session Name in Session properties. The session 
name is displayed on the screen during session. 

4. Select a type for the session, the options are HRmax (maximum heart rate) and 
Anaerobic threshold. See more information about session types in Session 

management. 

5. Determine the Intensity zones for the selected session: you can change the names 
and set the lower limits for the zones. Adjust the lower limits by clicking the up and down 
arrows. 

 A session can include from 3 to 5 intensity zones. 

 To delete a zone, click the delete icon   next to the zone. The software asks for 
your confirmation. NOTE: Only the lowest zone can be deleted. 

 To add a zone, click the Add button next to the intensity zones. The new zone 
appears to the bottom of the zone list. 
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 You can restore the default intensity zone settings by clicking Defaults next to 
the intensity zones. 

 

6. Click Add below the Advertisements list to add an advertisement. Select the file from 
the computer and select Open to confirm the selection. Repeat to add more 

advertisements. 

 

 Ads must be either in JPG, PNG, BMP or GIF format. See other advertisement 

instructions in the Session management topic. 
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 Uploaded advertisements can be viewed in the Preview box by selecting an ad 
from the list. 

 

How to modify session 

1. Open the admin tool from the Start menu: Start > All Programs > Polar Cardio GX > 
Polar Cardio GX Admin Tool. 

2. Under Session Management, select the session you want to modify by clicking it.  

 

3. When the session is selected, you can modify the session Name, Type, Intensity 
Zones and Advertisements. See more information on the settings in How to add 
session. 

Changes are saved automatically. 

NOTE: Sessions cannot be modified if a session is ongoing, because only either the admin tool 
or the session tool can be open at a time. 

How to remove session 
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1. Open the admin tool from the Start menu: Start > All Programs > Polar Cardio GX > 
Polar Cardio GX Admin Tool. 

2. Under Personalize session, select the session you want to remove by clicking it.  

3. Click the Remove button next to the sessions list. The software asks for your 
confirmation. 

 

NOTE: There must always be at least one session in the system. The software does not allow 
you to delete all the sessions. 

 

How to add advertisement 

You can add advertisements to the sessions you have created in the admin tool. See the 

instructions in the How to add sessions and How to modify sessions topics. 

Sessions 

How to start a session 

1. Set up the system.  
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2. Select a session from the left. You can see the selected session's settings next to the list. 

 

3. Select the connector number from the Number drop-down list. 

4. Type in your name / initials / nickname into the Name field. 

5. Check the Highlight in session box if you want your information to be highlighted on 
the screen during the session. 

6. Based on the selected training session, the system asks you either to select Maximum 
heart rate or Age and type in the value, or to set your Anaerobic threshold. 
 
In case the training session is based on maximum heart rate: 

 If you do not know your maximum heart rate, it can be calculated (estimated) 
based on your age (220 - age = maximum heart rate). 

 The age must be set between 10 and 99 years and the maximum heart rate 
between 120 and 250 beats per minute. If the value you give does not meet 
these limits, the background of the field is red. 

7. Select Exerciser sign-up. The exercisers sign up for the session. For more information 
see How to sign up. 

8. After all the exercisers have signed up for the session, the instructor selects Session in 
the Exerciser sign-up view.  

9. The names of the exercisers are displayed on the screen. Make sure everyone is ready 
to start the session.  

10. Click the start button   to start the session. 
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How to sign up 

All the exercisers must sign up for the class before the training session.  

Before signing up, the instructor: 

 sets up the system and opens the session tool from the Windows desktop (Polar 
Cardio GX Session Tool),  

 selects the training session type and fills in his/her information, and 

 opens the Exerciser sign-up view from the Instructor settings view. 

When the exercisers (wearing the transmitter) come to the Cardio GX room, the base station 
starts detecting the transmitter signals. The connector numbers start appearing in the sign-up 

view. An exerciser can sign up for the class after his / her connector number has appears in the 
view. 

Signing up: 

1. Select your connector number from the screen by clicking the number. A pop-up window 
appears. 

2. Type in your name / initials / nickname into the Nickname field. 

 

3. Based on the selected training session, the system asks you either to set your 
Maximum heart rate or Age, or your Anaerobic threshold.  
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In case the training session is based on maximum heart rate: 

 If you do not know your maximum heart rate, it can be calculated (estimated) 
based on your age (220 - age = maximum heart rate). 

 The age must be set between 10 and 99 years and the maximum heart rate 
between 120 and 250 beats per minute. If the value you give does not meet 
these limits, the background of the field turns red. 

4. Select OK to save the settings. Your connector number becomes disabled in the Sign-
up view. 

NOTE: If you selected a wrong connector number, select Cancel to return to the number 
selection without saving the changes. 

How to end session 

1. To end the training session, select the stop button .  

2. The Polar Cardio GX software displays an individual session summary for each 
exerciser. In addition to the exerciser's name, the average and maximum heart rate is 
displayed with the intensity zone summary. To enable comparing the times spent on each 

intensity zone, the durations are displayed in minutes and seconds and with colored bars. 

3. Close the session tool by selecting the exit button . 
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The Polar Cardio GX software records a session log for each session. See After training topic to 
get more detailed information. 

Starting a new session 

After the session has ended, it can be started again with the same exerciser data by clicking the 

start button . The timer is set to 00:00 again and previous heart rate data is erased.  

See more information in the After training topic. 

How to change session settings 

In the session tool, the session settings can be changed without losing the exerciser's information 
even after the heart rate-based session is started. This feature may become useful for example if 

the instructor selects a wrong session in the Instructor Settings view. 

1. If the session has already started, stop it by clicking the stop button . 

2. Click the settings button . 

3. Select a new session. NOTE: Sessions that are different type than the current selected 
session are disabled. 

4. Click OK to save the changes. 

Start (or re-start) the session by clicking the start button . The timer is set to 00:00 

again and previous heart rate data is erased. 

NOTE: After the session tool is closed by clicking the exit button , all the exerciser 

information (name, maximum heart rate / age) is lost and exercisers must sign in again to be able 
to participate to the session. 

How to follow up 

You, as a club owner, group exercise manager or Polar Cardio GX key user, can follow up and 
monitor arranged heart rate based classes. The Polar Cardio GX software records a session log 

for each session. 

The log file can be accessed from the admin tool. To open the log file, click on the log file button 

 in the upper right corner of the Session Management section of the admin tool. The 
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Sessions.csv file opens into Microsoft Excel or similar software. Make sure you have compatible 
software installed onto your computer. 

For more information about the log file, see After training topic. 

 



 

TROUBLESHOOTING 

Troubleshooting 

Troubleshooting offers you firsthand help when you have a problem either with the hardware or 

the PC software.  

The search engine in the help is helpful in many situations. The search engine can be found from 

the upper right corner. Additionally, lots of information can be found in the How to articles in How 

to section. 

Search tips 

 Use simple search words or sentences. Two or three words are enough. 

 Use basic forms of verbs. 

 The search engine does not understand the meaning of interrogatives like "why", "what" 
and "when". Instead use keywords, such as "transmitter", "green light" and "managing", 

as search words.  

Glossary 

There is also a glossary included in the help. It can be accessed by clicking the Glossary tab 

above the help menu. 

Training articles 

For more information on the physiological aspects and other features of Polar products, visit the 

Polar Collection of Training Articles. 

Connections 

Here is a check list for connection problems between the base station and a PC. When the 

connection between the base station and your PC is established correctly, the lights  and  
are lit on the base station. This requires that the Cardio GX software (either the admin or session 

tool) is running. 

 PC and Ethernet cable 

 PC and wireless connection 
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PC and Ethernet cable 

 Make sure that the Cardio GX software (either the admin or session tool) is running. 

 Make sure that the base station is switched on.  

 Make sure that you are using a correct type of network cable, like the one that was 
provided in the set. The cable must be a crossover RJ45 cable. 

 Make sure that the network cable is plugged in correctly to the base station and to your 
PC. 

 Check that the lights next to the Ethernet port on your PC are flashing. The flashing 
means that the connection is working. 

 Make sure that your Ethernet adapter is enabled in Windows settings: 

Windows XP: 

1. Select Start > (Settings >) Control Panel > Network connections. 

2. Right-click Local Area Connection. 

3. If the right-click menu includes option Enable, the adapter is at the moment 
Disabled. In this case, select Enable. 

Windows Vista: 

1. Select Start > Control Panel > Network and Sharing Center.  

2. Click View status of the Local Area Connection. 

3. If the Media State is disabled, click the Enable button at the bottom of the 
window. 

If you have checked all the issues mentioned above: 

1. Close the software and switch off the base station.  

2. Open the software and switch on the base station again. 

If the connection between the base station and your PC still does not work, check that the status 
of your LAN connection is Connected and the IP address of the base station is 192.168.42.x (x 
can be any number): 

1. Select Start > (Settings >) Control Panel > Network connections. 
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2. Right-click Local Area Connection and select Status. The status is displayed on the 
first page. 

3. Select Support tab. The IP address is displayed. 

If you have checked all the issues mentioned above: 

 Try to reboot your PC. 

 Update the drivers of the LAN adapter. Contact the adapter's manufacturer's web site. 

PC and Wireless connection 

If you have not tried to establish wireless connection between the base station and the PC before, 

see How to setup wireless connection. 

 Make sure that the Cardio GX software is running. 

 Make sure that the base station is switched on. 

 Make sure that your PC is trying to connect to the base station: 

 Windows XP: 

1. In Windows, select Select Start > (Settings >) Control Panel > Network 
connections. 

2. Right-click Wireless Network Connection and select View Available 
Wireless Networks. 

3. Select the base station's network (base station's name, Polar_XXXXXXXX) from 
the list and click Connect. 

4. Computer prompts you for the wireless network key. 

Windows Vista: 

1. In Windows, select Start > Connect to.  

2. Wait for couple of seconds while the computer searches for the networks. If your 

base station's name (Polar_XXXXXXXX) does not appear on the list, try to 
refresh the list by clicking the Refresh button in the upper right corner. 

3. Select Polar_XXXXXXXX from the networks list and click the Connect button. 

4. Computer prompts you for the wireless network key. 
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 Make sure you are using the correct wireless network key. The network key is set in the 
admin tool. If you have forgotten your wireless network key, change it according to the 

instructions. 

 If there are visible light indicators in your Wi-Fi adapter, check that they are flashing. The 

flashing means that the connection is working. 

 If you have a separate on/off switch for your Wi-Fi adapter (e.g. touch button on your 

laptop), make sure the adapter is switched on.  

 Make sure that your wireless connection adapter is enabled in Windows settings: 

Windows XP: 

1. Select Select Start > (Settings >) Control Panel > Network connections. 

2. Right-click Wireless Network Connection. 

3. If the right click menu includes option the Enable option, the adapter is currently 
Disabled. In this case, select Enable. 

Windows Vista: 

1. Select Start > Control Panel > Network and Sharing Center.  

2. Click View status of the Wireless Network Connection. 

3. If the Media State is disabled, click the Enable button at the bottom of the 
window. 

 Some computers block the Wi-Fi connection automatically if the Ethernet cable is 
plugged in. If this is the case, remove the Ethernet cable from the PC port. 

 Some computers block the Wi-Fi connection automatically if you are using a docking 
station. If this is the case, remove the laptop from the docking station. 

If you have checked all the issues mentioned above: 

1. Close the software and switch off the base station.  

2. Open the software and switch on the base station again. 

If you have checked all the issues mentioned above: 

 Try to reboot your PC. 
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 Update the drivers of the wireless connection adapter. Contact the adapter's 
manufacturer's web site. 

Online training 

Below you can find help to some common problems with online training. 

Problem Cause Solution 
Transmitter/Exerciser's 
information disappears from 
the grid. 

1. Connector's battery 
is empty. 

2. Strap's electrode 
areas are dry or 
strap is secured 
incorrectly. 

3. Connection between 
the PC and the base 
station is 
momentarily 
disconnected. 

4. Base station's 
battery is empty. 

5. The transmitter is 
out of the base 
station's range. 

1. Recharge 
connector's battery. 

2. Wet the electrode 
areas of the strap 
under running water. 
Make sure that the 
strap is secured 
correctly and the wet 
electrode areas are 
firmly against 
exerciser's skin. 

3. Wait for a moment. If 
connection is not 
restored, switch the 
base station off and 
on again. Also re-
open the software 
and establish 
connection between 
PC and base station 
normally. 

4. Plug the power 
cable into the base 
station and into wall 
outlet.  

5. Wait until the 
exerciser is again in 
the base station's 
range. Make sure 
nothing is interfering 
the connection from 
the transmitter to the 
base station. 

Transmitter/Exerciser is not 
shown during online training. 

1. Connector's battery 
is empty. 

2. Strap's electrode 
areas are dry or 
strap is secured 
incorrectly. 

3. Connection between 
the PC and the base 
station is not 
established 
correctly.  

1. Recharge 
connector's battery. 

2. Wet the electrode 
areas of the strap 
under running water. 
Make sure that the 
strap is secured 
correctly and the wet 
electrode areas are 
firmly against 
exerciser's skin. 
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4. Base station's 
battery is empty. 

5. There exerciser is 
not signed up for the 
session. 

6. Connector is in non-
secured mode. 

3. Make sure the 
connection between 
the base station and 
the PC is 
established 
correctly. 

4. Plug the power 
cable into the base 
station and into wall 
outlet. 

5. The exerciser should 
sign up for the 
session. 

6. Change the 
connector's mode to 
secured by removing 
the connector from 
charger and 
inserting it back after 
a minimum of 3 
seconds. Only one 
sound should be 
heard.  

 

Training computer 

Below you can find help to some common problems with training computer usage with the Cardio 

GX system. 

Problem Cause Solution 
The heart rate does not 
display on the training 
computer display. 

1. Your Polar training 
computer is not 
compatible with the 
Cardio GX 
transmitters. 

2. Your Polar training 
computer is not in 
training mode. 

1. For example, the 
following Polar 
training computers 
are compatible with 
the Cardio GX 
transmitters: FT40, 
FT60, FT80, 
RS300X, F4, F7, 
F11, S610i, S625X, 
S710i, S720i, 
S725X, S810i, 
AXN500 and 
AXN700. 

2. Set your training 
computer in training 
mode. Usually, it is 
done by pressing the 
Red or OK button 
twice. For more 
information, see the 

52 



Troubleshooting 

user manual of your 
Polar product. 

 

Transmitters 

Below you can find help to some common problems with transmitters with the Cardio GX system. 

Problem Cause Solution 
The connector cannot be 
taught to the system via 
admin tool. 

The connector is in secured 
mode, because it has 
already been paired with 
another base station. 

Change the connector's 
mode to non-secured by 
removing the connector from 
the charger and inserting it 
back within 3 seconds. 
When inserted into the 
charger, three short sounds 
are heard instead of one. 
Note that after you have 
taught the connector to the 
system, the connector's 
mode is automatically 
changed to secured. 

When inserted into charger, 
there is no sound or light. 

1. Power cable is not 
plugged into the 
charger. 

2. Connector is 
inserted into charger 
incorrectly. 

1. Plug the power 
cable into charger 
and into the wall 
outlet.  

2. Insert connector into 
the charger so that 
the P of Polar logo is 
not visible. The led 
is located next to the 
R of Polar logo. See 
How to insert 
connectors into 
charger for more 
information. 

Connectors are not shown 
as connected even if they 
are inserted into the charger 
correctly and there is a 
connection between the 
base station and the PC. 

1. Power cable is not 
plugged into the 
charger. 

2. The connectors are 
in non-secured 
mode. 

1. Plug the power 
cable into charger 
and into wall outlet.  

2. Change the 
connector's mode to 
secured by removing 
the connector from 
charger and 
inserting it back after 
a minimum of 3 
seconds. Only one 
sound should be 
heard.  

New connector does not 1. Connector is 1. Insert connector into 
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appear to the connector list 
in the admin tool. 

inserted into charger 
incorrectly. 

2. There is no 
connection between 
the base station and 
the PC. 

3. Contact problem 
between the 
connector and the 
charger. 

the charger so that 
the P of Polar logo is 
not visible. The led 
is located next to the 
R of Polar logo. 

2. Establish either a 
wired or wireless 
connection between 
the base station and 
the PC according to 
the instructions here. 

3. Remove the 
connectors that were 
not found from the 
charger and insert 
them back. You can 
also try to insert the 
connector into 
another slot of the 
charger. 

The number label has come 
off and you don't know which 
connector it is. 

 1. If only one connector 
doesn't have a label, 
check the rest of the 
connectors' labels. 
The number that is 
missing is the 
connector's number. 

2. If there are two or 
more connectors 
without a label, 
insert the connectors 
one by one into the 
charger (one at a 
time). Open the 
admin tool and 
establish connection 
between the base 
station and the PC. 
Wait until the 
connector is 
connected to the 
system. Find out 
which connector is 
marked as 
connected in the 
transmitter list. 
Repeat this until you 
know the numbers of 
each transmitter. 

 



 

CUSTOMER SERVICE INFORMATION 

Customer service information 

 Care and maintenance instructions 

 Precautions 

 Important safety information 

 Regulatory information 

 Radio frequency technical specification 

 Guarantee and disclaimer 

Service 

Your Polar Cardio GX system is designed to help you achieve your personal fitness goals and 

indicate the level of physiological strain and intensity during training sessions. No other use is 
intended or implied.  

During the one-year guarantee/warranty period we recommend that you have service done by an 
authorized Polar Service Center only. The warranty does not cover damage or consequential 
damage caused by service not authorized by Polar Electro.  

Register your Polar product at http://register.polar.fi to ensure we can keep improving our 
products and services to better meet your needs. 

 

Care and maintenance instructions 

It is important to follow the care and maintenance instructions to assure the long life of the Cardio 
GX hardware. Sweat and moisture can keep the electrodes wet and the transmitter activated, 

which shortens battery life. 

Transmitter straps 

 After training, detach the connector from the strap. 

 Rinse the straps under running lukewarm water after every use. 
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 Wash the straps in a washing machine at 40 °C (104°F) after every fifth use. Always use 
the washing pouch (included in the Cardio GX set). NOTE: Detach the connector from 

the strap before wash!  

 Do not use bleach or fabric softener.  

 Make sure straps are dry before storing. Do not store wet. 

Connectors 

 Detach the connector from the strap and store separately. 

 Rinse the connectors under running lukewarm water after every use. 

 Do not insert wet connectors into the charger. 

 You may store the connectors in the charger, but make sure the charger's power cable is 
not plugged in during storage. 

 When the transmitters are not in daily use or are stored for a longer period of time, 
recharge the connectors regularly to prevent a complete exhaustion of the batteries 
inside the connectors. 

Charger and base station 

 Wipe the base station and the charger regularly with a moist cloth. 

Precautions 

Minimizing Possible Risks 

Training may include some risk. Before beginning a regular training program, answer the 
following questions concerning your health status. If you answer yes to any of these questions, 

consult a physician before starting any training program. 

 Have you been physically inactive for the past 5 years? 

 Do you have high blood pressure or high blood cholesterol? 

 Do you have symptoms of any disease? 

 Are you taking any blood pressure or heart medication? 

56 



Customer service information 

 Do you have a history of breathing problems? 

 Are you recovering from a serious illness or medical treatment? 

 Do you use a pacemaker or other implanted electronic device?  

 Do you smoke?  

 Are you pregnant? 

Note that in addition to training intensity, medications for heart conditions, blood pressure, 

psychological conditions, asthma, breathing, etc., as well as some energy drinks, alcohol, and 
nicotine may also affect heart rate. It is important to be sensitive to your body’s responses during 
training. If you feel unexpected pain or excessive fatigue when training, stop the exercise or 

continue at a lighter intensity. 

If you have a pacemaker, defibrillator or other implanted electronic device, you use the Polar 

Cardio GX system at your own risk. Before starting use, take a maximal training stress test under 
the supervision of a physician. The test is to ensure the safety and reliability of the simultaneous 
use of the pacemaker and the Polar Cardio GX system. If you are allergic to any substance that 

comes into contact with your skin or if you suspect an allergic reaction due to using the product, 
check the listed materials in Technical Specifications. To avoid any skin reaction to the 
transmitter, wear it over a shirt. Moisten the shirt well under the electrodes to ensure flawless 

operation. If you use insect repellent on your skin, make sure that it does not come into contact 
with the transmitter. 

Exercise equipment with electronic components may cause interfering stray signals. To 
tackle these problems, try the following: 

1. Remove the transmitter from your chest and use the exercise equipment as you would 
normally. 

2. Move the wrist unit around until you find an area in which it displays no stray reading or 
does not flash the heart symbol. Interference is often worst right in front of the display 
panel of the equipment, while the left or right side of the display is relatively free of 
disturbance. 

3. Put the transmitter back on your chest and keep the wrist unit in this interference-free 
area as much as possible. 

If the Polar Cardio GX system still does not work, the piece of equipment may be electrically too 
noisy for wireless heart rate measurement. 

Polar Cardio GX transmitter may not be worn when swimming. For more information, visit 
http://support.polar.fi. Water resistance of Polar products is tested according to International 

Standard ISO 2281. Products are divided into three categories according to their water 
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resistance. Check the back of your Polar product for the water resistance category, and compare 
it to the chart below. Please note that these definitions do not necessarily apply to products of 

other manufacturers. 

Marking on case back Water resistant characteristics 
Water resistant Protected against wash splashes, sweat, 

raindrops etc. Not suitable for swimming. 
Water resistant 30 m/50 m Suitable for bathing and swimming 
Water resistant 100 m Suitable for swimming and snorkeling 

(without air tanks) 

 

Important safety information 

Base station 

 The detachable legs must be used when base station is placed on moist ground, e.g., on 

a wet lawn.  

 During charging the legs of the base station must be used because the bottom of the 

base station heats up to 60°C (140°F). During charging, the maximum operating 
temperature is 45°C (113°F). 

AC-powered devices 

These precautions apply to all products that plug into a standard wall power outlet.  

Failure to take the following precautions can result in serious injury or death from electronic shock 

or fire or in damage to the device. 

To select an appropriate power source for your device: 

 Use only the power supply unit and AC power cord that came with your device or that 
your received from an authorized repair center.  

 AC adapters are only for indoor use. 

 Confirm that your electrical outlet provides the type of power indicated on the power 
supply unit (in terms of voltage [V] and frequency [Hz]). If you are not sure of the type of 
power supplied to your home, consult a qualified electrician. 
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 Do not use non-standard power sources, such as generators or inverters,even if the 
voltage and frequency appear acceptable. Use only AC power provided by a standard 

wall outlet. 

 Do not overload your wall outlet, extension cord, power strip, or other electrical 

receptacle. Confirm that they are rated to handle the total current (in amps [A]) drawn by 
the device (indicated on the power supply unit) and any other devices that are on the 
same circuit. 

To avoid damaging the power cords and power supply: 

 Protect the power cords from being walked on. 

 Protect cords from being pinched or sharply bent, particularly where they connect to the 
power outlet, the power supply unit, and the device. 

 Do not jerk, knot, sharply bend, or otherwise abuse the power cords. 

 Do not expose the power cords to sources of heat. 

 Keep children and pets away from the power cords. Do not allow them to bite or chew on 
them. 

 When disconnecting the power cords, pull on the plug - do not pull on the cord. 

If a power cord or power supply becomes damaged in any way, stop using it immediately. Unplug 
your device during lightning stroms or when unused for long periods of time. 

For devices with an AC power cord that connects to the power supply, always connect the power 
cord according to the following instructions: 

1. Plug the AC power cord into the power supply unit until it stops. 

2. Plug the other end of the AC power cord into the wall outlet. 

Battery-powered devices 

These precautions apply to all products that use rechargeable or disposable batteries.  

Improper use of batteries may result in battery fluid leakage, overheating, or explosion. Released 

battery fluid is corrosive and may be toxic. It can cause skin and eye burns, and is harmful if 
swallowed. 

Rechargeable batteries only: 
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 Charge only with the recharger provided with the product. 

Wireless devices 

Such as Base station and transmitter. 

Before boarding any aircraft or packing a wireless device in luggage that will be checked, remove 

the batteries from the wireless device or turn the wireless device off (if it has an on/off switch). 
Wireless devices can transmit radio frequency (RF) energy, much like a cellular telephone, 
whenever batteries are installed and the wireless device is turned on (if it has an on/off switch). 

All devices 

Do not attempt repairs 

Do not attempt to take apart, open, service, or modify the hardware device or power supply. 

Doing so could present the risk of electrical shock or another hazard. Any evidence of any 
attempt to open and/or modify the device, including any peeling, puncturing, or removal of any of 

the labels, will void the Limited Warranty. 

Choking hazard 

This device may contain small parts that which may be a choking hazard to children under 3. 

Keep small parts away from children.  

Regulatory Information 

 Base Station 

 Transmitter 

 Charger 

Base Station 

FCC regulatory information 

This device complies with part 15 & 18 of the FCC rules. Operation is subject to the following two 

conditions: (1) This device may not cause harmful interference, and (2) This device must accept 
any interference received, including interference that may cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules and for a miscellaneous type ISM device, pursuant 
to part 18 of the FCC Rules. These limits are designed to provide reasonable protection against 

harmful interference in a residential installation. This equipment generates, uses, and can radiate 
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radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one or more of the 

following measures: 

1) Reorient or relocate the receiving antenna. 

2) Increase the separation between the equipment and receiver. 

3) Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected. 

4) Consult the dealer or an experienced radio/TV technician for help. 

Caution! Changes or modifications not expressly approved by the party responsible for 

compliance could void the user's authority to operate the equipment. 

FCC Radiation Exposure Statement 

The radiated output power of the Base Station is far below the FCC radio frequency exposure 

limits. Nevertheless, the Base Station should be used in such a manner that the potential for 
human contact during normal operation is minimized. To avoid the possibility of exceeding the 
FCC radio frequency exposure limits, you should keep a distance of at least 20 cm between you 

and the Base Station.  

Industry Canada (IC) regulatory information  

This device complies with RSS-210 and ICES-001of Industry Canada rules. Operation is subject 

to the following two conditions: (1) This device may not cause harmful interference, and (2) This 
device must accept any interference received, including interference that may cause undesired 
operation. 

Industry Canada (IC) Radiation Exposure Statement 

The radiated output power of the Base Station is far below the Industry Canada radio frequency 
exposure limits. Nevertheless, the Base Station should be used in such a manner that the 

potential for human contact during normal operation is minimized. To avoid the possibility of 
exceeding the Industry Canada radio frequency exposure limits, you should keep a distance of at 
least 20 cm between you and the Base Station.  

Europe 
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This product is compliant with Directives 93/42/EEC and 1999/5/EC. The relevant Declaration of 

Conformity is available at www.polar.fi/support. 

 

Polar products are electronic devices and are within the scope of Directive 2002/96/EC of the 
European Parliament and of the Council on waste electrical and electronic equipment (WEEE). 

These products should thus be disposed of separately in EU countries. Polar encourages you to 
minimize possible effects of waste on the environment and human health also outside the 
European Union by following local waste disposal regulations and, where possible, utilize 

separate collection of electronic devices. 

South Africa 

 

Transmitter 

FCC regulatory information  

This device complies with part 15 of the FCC rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) This device must accept 

any interference received, including interference that may cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits for a Class B digital 

device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses and can radiate radio frequency energy and, if not installed and used in accordance with the 
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instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause 

harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of 
the following measures: 

1) Reorient or relocate the receiving antenna. 

2) Increase the separation between the equipment and receiver. 

3) Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 

4) Consult the dealer or an experienced radio/TV technician for help. 

Caution! Changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment. 

Industry Canada (IC) regulatory information  

This device complies with RSS-210 of Industry Canada rules. Operation is subject to the following 
two conditions: (1) This device may not cause harmful interference, and (2) This device must 

accept any interference received, including interference that may cause undesired operation. 

Europe 

 

This product is compliant with Directives 93/42/EEC and 1999/5/EC. The relevant Declaration of 
Conformity is available at www.polar.fi/support. 

 

This marking shows that product is protected against electric shocks. 
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Polar products are electronic devices and are within the scope of Directive 2002/96/EC of the 
European Parliament and of the Council on waste electrical and electronic equipment (WEEE). 
These products should thus be disposed of separately in EU countries. Polar encourages you to 

minimize possible effects of waste on the environment and human health also outside the 
European Union by following local waste disposal regulations and, where possible, utilize 
separate collection of electronic devices. 

South Africa 

 

Charger 

FCC regulatory information  

This device complies with part 18 of the FCC rules. Operation is subject to the following two 

conditions: (1) This device may not cause harmful interference, and (2) This device must accept 
any interference received, including interference that may cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits for a miscellaneous 
type ISM device, pursuant to part 18 of the FCC Rules. These limits are designed to provide 

reasonable protection against harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. 

However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 

interference by one or more of the following measures: 

1) Reorient or relocate the receiving antenna. 
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2) Increase the separation between the equipment and receiver. 

3) Connect the equipment into an outlet on a circuit different from that  

to which the receiver is connected. 

4) Consult the dealer or an experienced radio/TV technician for help. 

Caution! Changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment. 

Industry Canada (IC) regulatory information  

This ISM device complies with ICES-001of Industry Canada rules. Operation is subject to the 

following two conditions: (1) This device may not cause harmful interference, and (2) This device 
must accept any interference received, including interference that may cause undesired 

operation. 

Europe 

 

This product is compliant with Directives 93/42/EEC and 1999/5/EC. The relevant Declaration of 
Conformity is available at www.polar.fi/support. 

 

Polar products are electronic devices and are within the scope of Directive 2002/96/EC of the 
European Parliament and of the Council on waste electrical and electronic equipment (WEEE). 
These products should thus be disposed of separately in EU countries. Polar encourages you to 

minimize possible effects of waste on the environment and human health also outside the 
European Union by following local waste disposal regulations and, where possible, utilize 
separate collection of electronic devices. 

South Africa 
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technical specifications 

Transmitter 

Transmitter strap material:  

 35 % Polyester, 35 % Polyamide, 30 % Polyurethane. 

Connector material:  

 Back cover: PA+GF,  

 Press-buttons: stainless steel AISI316,  

 Front cover: ABS + GF, 

 Lense on the front cover: PMMA 

Radio frequency technical specifications 

Charger unit 

Frequency: 13.56 MHz, Industrial-Scientific-Medical (ISM) band used. 

Bluetooth devices 

Base station 

RF output power: meets Bluetooth® requirements. 
Frequency: 2400 MHz to 2483.5 MHz, max. 100 mW. 
Bluetooth QD ID B011340. 

Connector 

RF output power: meets Bluetooth® requirements. 
Frequency: 2400 MHz to 2483.5 MHz, max. 20 mW. 
Bluetooth QD ID B011340. 
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2.4 GHz devices (such as base station and transmitter) 

Non-specific short range device. 

RF output power: meets all SRD requirements. 

Frequency: within the range of 2400 MHz to 2483.5 MHz. 

For Bluetooth and 2.4 GHz devices only: to comply with FCC RF exposure requirements, the 
following operating configurations must be satisfied: the antenna has been installed by the 

manufacturer and no changes can be made.  

Guarantee and disclaimer 

Limited polar international guarantee 

 This limited Polar international guarantee is issued by Polar Electro Inc. for the 

consumers who have purchased this product in the USA or Canada. This limited Polar 
international guarantee is issued by Polar Electro Oy for the consumers who have 

purchased this product in other countries. 

 Polar Electro Inc. / Polar Electro Oy guarantees to the original consumer/ purchaser of 

this product that the product will be free from defects in material or workmanship for one 
year from the date of purchase. 

 Please keep the receipt as a proof of purchase! 

 The guarantee does not cover the battery, damage due to misuse, abuse, accidents or 

non-compliance with the precautions; improper maintenance, commercial use, cracked or 
broken cases. 

 The guarantee does not cover any damage/s, losses, costs or expenses, direct, indirect 
or incidential, consequential or special, arising out of, or related to the product. During the 
guarantee period the product will be either repaired or replaced at an authorized service 

center free of charge. 

 This guarantee does not affect the consumer’s statutory rights under applicable national 

or state laws in force, or the consumer’s rights against the dealer arising from their sales/ 
purchase contract. 

© 2009 Polar Electro Oy, FIN-90440 KEMPELE, Finland. 

Polar Electro Oy, FIN-90440 KEMPELE, Finland. Polar Electro Oy is a ISO 9001:2000 certified 

company. All rights reserved. No part of this manual may be used or reproduced in any form or by 
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any means without prior written permission of Polar Electro Oy. The names and logos marked 
with a ™ symbol in this user manual or in the package of this product are trademarks of Polar 

Electro Oy. The names and logos marked with a ® symbol in this user manual or in the package 
of this product are registered trademarks of Polar Electro Oy, except that Windows is a trademark 
of Microsoft Corporation. 

Disclaimer 

 The material in this manual is for informational purposes only. The products it describes 
are subject to change without prior notice, due to the manufacturer’s continuous 

development program. 

 Polar Electro Inc. / Polar Electro Oy makes no representations or warranties with respect 

to this manual or with respect to the products described herein. 

 Polar Electro Inc. / Polar Electro Oy shall not be liable for any damages, losses, costs or 

expenses, direct, indirect or incidental, consequential or special, arising out of, or related 
to the use of this material or the products described herein. This product is protected by 
the incorporeal rights of Polar Electro Oy as defined by the following documents: FI 

20075426, US 21/133888, EP 08157710.8, FI115084, US7418237, EP1543769, 
FI110915, US7324841, US7018339, FI114202, US6537227, EP1147790, HK1040065, 
FI96380, JP3568954, US5611346, EP665947, FI23471, EU00046107-0001, 

USD492783S, USD492784S, USD492999S. Other patents pending. 

Manufactured by Polar Electro Oy, Professorintie 5, FIN-90440 KEMPELE, Tel +358 8 5202 100, 

Fax +358 8 5202 300, www.polar.fi 



 

GLOSSARY 

A 
admin tool: Part of the Polar Cardio GX software, for managing the sessions, advertisements 

and hardware 

aerobic: Uses oxygen 

anaerobic: Without oxygen 

B 
base station: Unit that connects the transmitters with the PC software 

bpm: Beats per minute, heart rate 

C 
charger: Unit that is used to re-charge the batteries of the connectors 

connector: Black plastic part of the transmitter that transmits the heart rate data to the base 
station or training computer 

H 
hardware: Equipment, devices. In this case all the equipment that is included in the Polar Cardio 

GX set. 

HR: Heart rate, beats per minute 

HRmax: Maximum heart rate 

HRR: Heart rate reserve, the difference between the resting and maximum heart rate 

I 
intensity zone: Heart rate range that has a color, name and the lower and upper limits. A 

session can include 3 to 5 intensity zones 

P 
PolarZone session: Default session in the Polar Cardio GX software, can be deleted and 

modified by the user 

R 
recovery HR: A measure that indicates how long it takes for an exerciser's heart to slow down 

after been exercised as hard as possible 
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recovery time: An estimated time that it takes for an exerciser to recover after training, individual 
calculations 

S 
session: Template for heart rate-based class or the actual heart rate-based class 

session tool: Part of the Polar Cardio GX software, used before a class for signing up, during the 

class for heart rate monitoring, and after the class for summarizing the individual heart 
rate data 

software: PC application, in this case Polar Cardio GX software 

T 
teaching: Introducing connectors to the Polar Cardio GX system 

training computer: Polar product that can be used to monitor and record heart rate data 

transmitter: Unit that consists of a transmitter strap and a connector, detects and transmits heart 
rate data 

transmitter strap: Textile part of the transmitter that is tied around one's chest 

V 
VO2max: The unit for oxygen uptake is millilitres per minute per weight unit (ml/min/kg). The 

VO2max values vary between 35–85 ml/min/kg, depending on the individual’s 

performance and sport. 
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